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Foreword
Seeing Plug In with onOne Software come to fruition means a great deal 
to me, and being asked to write its foreword is icing on the cake. You see, 
the software that this book encapsulates, the company that created it, and 
the author who penned this book all mean a great deal to me. I’ve been a 
devoted user of the Perfect Photo Suite for many years, and I attribute much 
of my success as a photographer squarely to its tools. 

As onOne Software’s curriculum and education manager, I’ll occasionally 
roam around the engineering, development, and QA sections at the office to 
peek at the engineers’ displays. Usually, I am greeted to windows of code—
lots of code. To see the magical and creative ways that you, the photographer, 
use the tools built on these thousands upon thousands of lines of code is 
nothing short of astounding. This book will help you get the most out of  
Perfect Photo Suite 7 so you can amaze me even more.

At its core, we built Perfect Photo Suite 7 to serve as an extension of your 
creativity. We wanted to provide you with a finely tuned instrument that can 
provide beautiful results in a scalable way, from the casual user who simply 
wants to apply a one-click effect to the power user who loves spending hours 
digging deep into the fiber of what makes this suite of tools so powerful. We 
all have our own sensibilities around style when it comes to post-processing 
and the Perfect Photo Suite was built to help each of you find, refine, and 
evolve what that means.

When you first launch Perfect Photo Suite 7, you’re going to see the product 
of so many months of labor. In its truest form, this was a labor of love for us 
at onOne. Every aspect of every module, from the fonts used to the order that 
the tools were laid out, was carefully discussed, debated, and even argued 
over. Nothing was deemed as trivial.  But every decision was made with one 
overriding purpose in mind: to build the most powerful and inspiring collection 
of photo editing products for you, providing everything you need to realize 
your photographic vision.
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To that end, Plug In with onOne Software is a wonderful complement to the 
Perfect Photo Suite. You might say it’s the perfect complement. With Nicole 
Young as the book’s author, you will be treated to some of the best educa-
tional material out there. If there is one skill that Nicole excels at, it is sharing 
her knowledge in a way that is clear, approachable, and easy to understand. 
She thrives on turning obscure topics like layer masks, blending options, and 
resize algorithms into material that is truly easy to grasp and, more importantly, 
to use. In these pages, you’ll tour every single product and its tools and follow 
along through step-by-step examples of those tools in action. Every discussion 
is supported by beautiful imagery—all processed using Perfect Photo Suite 7.  
This book is one of the most comprehensive resources for using Perfect Photo 
Suite 7 to its fullest potential.

Nicole took such great care to make sure every corner of the Perfect Photo 
Suite was represented and explained in a familiar tone. From her frequent 
visits to the onOne Software office in Portland to her whimsical, ad hoc video 
chats with Senior Product Manager Dan Harlacher, Nicole made it her num-
ber one priority to thoroughly learn every feature, every tool, and every menu 
item that makes up Perfect Photo Suite 7. I’ll be the first to admit to learning 
a number of new things about software during the tech-editing phase of this 
book. In turn, for all of her effort, Nicole was able to synthesize this material 
in a way that will truly engage you and make you excited to run out the door, 
grab some new photos, and launch them in the Perfect Photo Suite as soon 
as you get home.

I hope you enjoy the inspiring words and imagery that Nicole shares in the 
coming pages. It is my sincerest wish that her efforts serve as inspiration for 
you as you learn all about the power of Perfect Photo Suite 7.

Never stop shooting. Never stop sharing.

 
Brian Matiash 
Curriculum and Education Manager 
onOne Software

xi



Introduction
Post-processing can, at times, feel like a necessary evil. We photographers 
tend to enjoy the photography side of things and dread staring at pixels in 
front of a glowing computer monitor to create the final image. I definitely put 
myself into that category; I don’t hate post-processing, I just prefer to spend 
my time doing something else. 

In writing Plug In with onOne Software, however, I had to dig deep into every 
crevice of Perfect Photo Suite 7 to discover its potential, and during that 
process I learned so much more than I expected. And then a surprising thing 
happened: I began to enjoy editing my photos with my newfound knowledge. 
Now, I’m often excited to import images into my computer because I look 
forward to seeing what I can do with them in the Perfect Photo Suite 7. The 
editing process has become my playground. My hope is that the Perfect 
Photo Suite, along with this book, will encourage you to enjoy the process of 
experimenting with your photos, too.

Not only will you learn more about the software, you may discover new ways 
to edit your photos. While writing, I uncovered a few that had never occurred 
to me. When working on Chapter 3, “Perfect Mask,” for example, I quickly 
realized how easy it was to mask a subject out of a scene and swap in a new 
backdrop, and it has inspired me to create more composite images. And, with 
the introduction of the brand-new product, Perfect B&W, I now have an easily  
accessible and simple-to-use tool to convert images into gorgeous black and 
white photographs. In-between the pages of writing each chapter I found ways 
to breathe new life into old photographs I had nearly forgotten about. I don’t 
believe that we can use software and plug-ins as a quick fix to create a beau-
tiful work of art from a crappy photograph, but we can use the software for a 
boost of inspiration and fuel the fire of our creative minds.
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This book is not intended to be read from cover to conclusion; rather, it was 
made for you to jump around and learn about the specific areas you need 
help with the most. In Chapter 1, “Getting Started,” I spell out some of the 
best practices for using the software, such as setting up your computer and 
preparing your files, and from there I dive straight into each specific product 
in Perfect Photo Suite 7. The chapters are laid out in the same order you’ll 
find the products in the software, and to make things easy, you’ll always know 
which product you’re reading about just by looking at the top of the page. 
Chapters 2 through 7 each have a “step by step” section at the end to demon-
strate how to process one or more images in that product; and you can learn 
how to enlarge, sharpen, and get your images ready for printing in Chapter 8,  
“Perfect Resize.” Chapter 9, “Perfect Integration,” brings the workflow together 
by showing how to process images in more than one product in the Perfect 
Photo Suite. You’ll learn not only what the features can do, but also how you 
can combine them for spectacular results.

So, whether you’re new to the onOne Software products or you’ve been using 
them for several years, you’re bound to learn a thing or two in Plug In with 
onOne Software. My goal was to create an intensive book covering as many 
features of the Perfect Photo Suite 7 that I could fit inside of each of these 
pages. I hope that in reading this book you get as excited and inspired about 
photography as I did while writing it.

NOTE

No book ever seems to have enough room to fit all the useful information about a product, 
so I was selective about what I included in each chapter. Because I just had to share a little 
more information that might come in handy, however, I’ve provided a bonus for you online. 
As an added value for you, I wrote an appendix, “Keyboard Shortcuts,” which covers the 
keyboard shortcuts you can use as you are working in the software. To access it, log in to 
or join Peachpit.com (it’s free), then enter the book’s ISBN. After you register the book, a 
link to the bonus content will be listed on your Account page under Registered Products.
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An adorable face needs only subtle adjustments to enhance the photograph.

Nikon D200, 50mm, 1/500 sec at f/2.8, ISO 100
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PERFECT 
PORTRAIT

Creating a beautiful portrait is an art form, and post- 
processing the image is part of that art. The elusive goal  
is a balance between keeping your model recognizable  
and enhancing facial qualities, but finding that balance can 
be a time-consuming challenge. After all, you’re not trying 
to hide who the subject is, but rather exaggerate the beauty 
that’s already there while removing the distractions, such as 
blemishes and harsh lines. Perfect Portrait automates these 
tasks, while still giving you full control over the retouching 
of your portraits, which not only helps you create beautiful 
images but also saves you precious time.

Chapter 

4
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The Perfect Portrait Interface

When to Use Perfect Portrait
Not every photograph of a person is going to need extensive (or even basic) 
retouching, but when your subject’s face is the main highlight of the frame, 
then Perfect Portrait is an excellent solution for your editing workflow. Here 
are a few other occasions when this software is a good choice:

 • Quick portrait edits: Perfect Portrait uses facial recognition to locate  
key areas on the face, such as the eyes and mouth. Enabling you to  
automate your retouching, this feature makes quickly enhancing and 
beautifying any portrait easy.

A Effects, Favorites, and Presets
B Browser mode
C Tool Options bar
D Module selector
E Tool-well

F Face Select tool
G Face Edit tool
H Retouch brush
I Hand and Zoom tools
J Navigator, Loupe, and Histogram

K Adjustment panes
L Mask View mode
M Preview mode
N Cancel and Apply buttons

A

B

C D

M

L
N

K

J

F

H

E

G

I

E
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 • Presets and batch edits: For those occasions when you have several 
portraits of the same person, such as senior portrait or bridal sessions, 
for example, you can create a preset for that individual and then apply it 
to the rest of your images. What’s even more impressive is the ability to 
batch edit with these presets (using Adobe Photoshop or Lightroom) to 
quickly go through a large set of images at once.

 • Individual retouches in group photos: For groups of two or more 
people, you can separate and edit each face individually. Because each 
face is unique and requires different types of edits, this software allows 
you to fine-tune the adjustments specifically for each person.

Portrait Retouching
When retouching portraits, remember above all else that subtlety is key. When 
we photograph people, we hope to create a memory, a moment in time, and a 
glimpse of who they are. Because of this, you want to avoid overworking the  
image, but to instead enhance it just enough so that the subject’s personality  
and true self shine through. Finding that balance of beautiful retouching without 
making a person’s skin, eyes, or teeth look fake is something you can easily 
do with Perfect Portrait. Inside, you’ll find tools to adjust each of these so that 
your images look beautiful and realistic. 

Before you can do any portrait retouching, however, you first need to hone 
in on the face or faces you’re going to work on. Perfect Portrait’s automated 
facial recognition makes step is easy, plus you can refine the identified facial 
elements to make the rest of your editing a breeze.

Facial Recognition
When you launch Perfect Portrait, you’ll notice that 
it does some initial “thinking” while it’s searching 
for people in your image (FIGURE 4.1). The software 
locates these faces and then places each into its 
own Face Box. Next, it creates masks separating 
the various parts of the face, such as the eyes and 
mouth. You then can use these masks to selectively 
edit each area individually.

FIGURE 4.1 Perfect Portrait first searches for faces 
and finds their features. This usually takes only a few 
seconds for each face in your image.
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Once Perfect Portrait finishes its work, you can start your own. First, make 
sure Perfect Portrait discovered all of the faces you want to edit. If you don’t 
see boxes around all the faces you want, you need to do a little prep work to 
the face selection, such as:

 • Adding a Face Box: If Perfect Portrait can’t locate a face in your image 
automatically, it displays the Add Face dialog box informing you that you 
need to add a face (FIGURE 4.2). To do this, just drag the Face Box you 
see on your screen over the face, resizing it with the handles on the box 
border so that the entire face is in the box. Click the Apply button in the 
Add Face pop-up window when you’re finished. Alternately, you can add 
a face by choosing Face > Add Face in the menu bar.

 

 • Selecting multiple faces: If Perfect Portrait found at least one face, 
but couldn’t locate all the faces in your image, you can use the Face 
Select tool to add more faces. Click the new face you want to add, and 
resize the Face Box that appears so that only the face is inside the box 
(FIGURES 4.3 and 4.4). When you’re satisfied, click Apply in the Add Face 
pop-up window.

FIGURE 4.2 If a face is partially obscured or the entire face is not showing, Perfect Portrait may be unable to find it. 
When this happens, you can quickly adjust the Face Box to identify the face in your image.
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 • Removing a Face Box: You can also delete Face Boxes from inside 
your image using the Face Select tool, which can be helpful if the soft-
ware didn’t locate the face properly the first time. With the Face Select 
tool active, click the X in the top-left corner of the Face Box you want 
to remove (FIGURE 4.5). The software will delete it and display a new 
Face Box. You can then either add a new face or cancel the process. 

FIGURE 4.3 Perfect 
Portrait found only 
three of the faces in 
this group.

FIGURE 4.4 Too add 
a fourth face, I clicked 
the little boy’s face on 
the left, resized the 
new Face Box that 
appeared, and clicked 
the Apply button.
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Alternately, you can delete any face by clicking the Face Box and  
choosing Face > Delete Face in the menu bar.

HOT TIP

You can remove a Face Box only when the image contains more than one Face Box, 
because the software needs at least one face in order to work.

Refining the Face
Perfect Portrait’s facial recognition algorithm not only finds faces in your 
image; it also locates the eyes, lips, teeth, and skin within each Face Box. If 
the white control outlines are perfectly situated around each of these areas, 
then that’s excellent! You can move along to the next section to start retouch-
ing your portrait. The algorithm doesn’t always get the controls into their 
proper place, however, and you need a little bit of manual override. This is 
when the Face Edit tool will come into play.

The Face Edit Tool
To get started, first you need to activate a Face Box. If you’re still inside the 
Face Select tool, click the Face Box you want to edit to automatically activate 
the Face Edit tool and zoom in. You can also click the Face Edit tool in the 

FIGURE 4.5 To delete 
a Face Box, click on 
the X in the upper-left 
corner of the box.
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tool-well to activate and zoom in to whichever box is highlighted in green 
(FIGURES 4.6 and 4.7).

FIGURE 4.6 The boy on the left is highlighted in green, indicating his box is selected with the Face Select tool.

FIGURE 4.7 I can start editing this face with the Face Edit tool by clicking the face inside the green box or by 
clicking on the Face Edit tool in the tool-well. The preview zooms in on that face and displays the eyes and 
mouth controls.
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Notice the controls that outline around the eyes and 
mouth. If the software was able to find the face well, then 
the controls will be in the right spots (FIGURE 4.8). If you 
need to adjust them, however, just drag the points to the 
correct locations. For the eyes, for example, be sure to  
put the blue point right on the pupil. Next, move the dots 
on the side to the corners of the eyes, and adjust the top 
and bottom points along the curve of the inside eyelids 
so that the eyeball is the only thing inside of the controls 
(FIGURE 4.9). For the mouth, three sections encompass 
your controls: two for the lips and one for the teeth. Make 
sure that the teeth are in the middle section, and the lips 
are in the top and bottom sections (FIGURE 4.10). For images 
with no teeth, just close the middle gap so it’s no longer 
visible (FIGURE 4.11).

FIGURE 4.8 Perfect Portrait did an excellent 
job of initially finding the locations for the 
eyes and mouth.

FIGURE 4.9 To refine the controls, just use the cursor to 
click and drag them into position.

FIGURE 4.11 This example shows proper placement of 
the controls over a mouth with no visible teeth.

FIGURE 4.10 This example shows proper placement of 
the controls over a mouth with visible teeth.
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Refining the Mask
Perfect Portrait also creates a mask to isolate the skin from the rest of the 
image, which allows you to use the Skin Retouching pane to edit only the 
skin areas of the face. As you can all other masks in the Perfect Photo Suite, 
you can adjust the skin masks by painting. When the Face Edit tool is active 
the cursor automatically defaults to a brush, so all you need to do is start 
painting to make changes.

Before you make any brush strokes in your image, preview the mask so 
you can see what, if anything, you need to adjust. Previewing the mask is 
extremely useful for this type of edit, as the changes the Skin Retouching 
tools make to your image are usually so subtle that you might not even know 
if something is awry until it’s too late. To preview the mask, click Ctrl+M. 
You’ll see a red overlay of the areas that are masked out. The portions of your 
image that are not in red should be the skin areas. You can choose among 
four mask view modes: Red, White, Black, and Grayscale (FIGURES 4.12 
through 4.15). To access each of these, choose View > Mask View Mode, or 
use the black box on the bottom left of the Preview window.

FIGURE 4.12 The default 
preview, the Red mask can 
help you locate areas of 
skin or no skin that need  
to be corrected.

FIGURE 4.13 The White 
mask is another way to  
preview the mask in  
Perfect Portrait.

FIGURE 4.14 Use the  
Dark mask preview when 
your image has areas of  
red already, such as a red 
backdrop or bright red hair.

FIGURE 4.15 The Grayscale 
mask helps you refine  
your mask by showing a 
black-and-white preview.
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Now that you know what your mask looks like, you’re ready to start fixing 
it. Here are some of the settings in the Tool Options bar you can use when 
painting the mask to reveal only the skin (FIGURE 4.16):

 

 • Mode: There are two options for the Mode setting: Add to Skin and Not 
Skin. Use the Add to Skin option when you want to reveal the skin areas 
of your portrait, and use the Not Skin option when portions of the mask 
reveal more than skin, such as hair or clothing (FIGURE 4.17).

 • Size: The Size setting determines the overall size of the brush, and 
ranges from 1 (a small brush) to 500 (a large brush). Use the smallest 
brush size possible in your image for more accurate results.

 • Feather: The Feather setting determines how soft or harsh the edge of 
your brush is, and ranges from 0 (a very harsh edge) to 100% (a very 
soft edge). To soften the transition of your mask, keep the feather at a 
higher setting, usually above 50.

 • Opacity: This setting determines how transparent your brush stroke is, 
and ranges from 0 (completely transparent) to 100 (completely opaque). 
For most cases you’ll be okay leaving this setting at 100. If you want to 
refine the edges of your mask around a hairline, wispy bangs, or men’s 
facial hair, try lowering the opacity slightly and painting along the border 
of the area (FIGURE 4.18). This will give you a smoother transition when 
making heavy adjustments with the Skin Retouching pane.

FIGURE 4.16 The Tool Options bar allows you to change your settings when refining the mask.

FIGURE 4.17 (left)  
I used the brush to 
paint with a Mode set-
ting of Not Skin over 
the area just to the 
right of her face.

FIGURE 4.18 (right) 
Painting with the Not 
Skin mode at 20% 
opacity allowed me to 
mask out a stray strand 
of hair over this little  
girl’s face.

130

PLUG IN WITH ONONE SOFTWARE



A few additional buttons on the far right side of the Tool Options bar are  
also handy: 

 • Next and Previous Face Arrows: When you’re working on more than 
one face, these buttons are the quickest way to jump back and forth 
between the Face Boxes in your image. Click on the right arrow to go to 
the next face, and use the left arrow to move back to the previous face. 
The Preview window will automatically fill with the new Face Box and 
allow you to make your refinements and retouching adjustments.

 • Hide Controls: After you have the eyes and mouth controls set in 
the right place, you can click on this button to hide the white outlines 
(FIGURES 4.19 and 4.20). Hiding the outlines will give you a clearer viewing 
experience when using the adjustment panes on the right side of your 
window, particularly when making adjustments to the eyes and mouth.

 • Reset Face: If you want to start over with any of the adjustment panes 
(Skin Retouching, Color Correction, Mouth & Eyes), click the Reset Face 
button. This feature resets the edits and the mask to only the currently 
selected face; it will not reset the eyes and mouth controls, or any edits 
you made with the Retouch brush.

HOT TIP

If you want to reset 
the edits to your 
face and start from 
scratch, click the 
face you want to 
reset and then 
choose Face > 
Reset Face in the 
menu bar. This 
method resets only 
one face at a time.  
If you want to reset 
all faces in your 
image, choose Edit > 
Reset All Faces.

FIGURE 4.19 By default, Perfect Portrait 
displays controls over the eyes and mouth. 
To hide these, click the Hide Controls  
button in the Tool Options bar.

FIGURE 4.20 After you hide the controls, the 
toggle changes to a Show Controls button; 
click it to show the controls over the eyes 
and mouth.
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Skin Retouching
Smooth and beautiful skin is something you will likely strive for in many of 
your images, and with Perfect Portrait you have the tools to create blemish-
free portraits very quickly and easily. The key with skin retouching is to not 
overdo the effect so much that the skin looks like plastic, or that freckles are 
completely gone. (Freckles can be cute, especially on little kids!) Keeping 
that texture in a person’s face keeps the reality alive while still showing each 
individual at his or her best.

Inside of this software you will find two main adjustments for retouching skin: 
the Retouch brush and the Skin Retouching pane. The Retouch brush clears 
away individual blemishes and lines, and the Skin Retouching pane applies 
global adjustments to the skin in your portrait.

Retouch Brush
When you need to remove a blemish or a flyaway hair, reach for the Retouch 
brush in the tool-well. You can find the tool’s three settings in the Tool 
Options bar on the top of your window:

 • Size: The Size setting ranges from 0 to 2500 pixels. For the majority of 
your retouching needs, you will usually want to set this to a low number. 
To prevent any smudging in the surrounding skin, keep Size set to just 
larger than the blemishes you’re trying to remove.

 • Feather: The Feather determines how soft the edge of your brush will 
be and ranges from 0 (a very harsh edge) to 100 (a very soft edge). 
Try keeping this setting to at least 25 to ensure smooth blending of the 
retouch areas with the existing skin.

 • Opacity: Opacity, ranging from 0 to 100, refers to how transparent or 
opaque the brush will be when you make your edits. A high number, 
such as 100, completely removes the blemish. If you want to make more 
subtle adjustments to areas of the skin, try setting this to around 50 or 
lower. This is a good way to subtly remove lines and wrinkles, as well as 
to brighten the areas underneath the eyes.
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Consider a few of the ways you can use the Retouch brush to make your 
portraits clean and beautiful:

 • Remove blemishes: Just one click on your image will immediately 
erase any blemishes. When using the brush for specific areas, keep it to 
about the same size, or maybe just a little larger than the blemish you’re 
erasing and make individual clicks instead of brushing over larger areas 
(FIGURES 4.21 and 4.22).

 • Fade wrinkles and lines: The Retouch brush is great for softening lines 
and wrinkles in an image. You’ll still want to keep some definition of the 
lines intact to keep the face looking natural, so the key is to reduce the 
Opacity setting below 50% and then make a few brush strokes over the 
lines. Also, be sure that your brush size is at the smallest setting possible 
so that you’re affecting only the lines on the face (FIGURES 4.23 and 4.24).

FIGURE 4.21 (left) 
A Size of 90 and a 
Feather of 11 with 
the Retouch Brush is 
enough to remove this 
blemish.

FIGURE 4.22 (right)  
By clicking just once 
with the Retouch 
Brush, I removed the 
blemish completely.

FIGURE 4.23 (left)  
To fade away the lines 
around this woman’s 
mouth I will use the 
Retouch Brush at a 
low opacity.

FIGURE 4.24 (right) 
With the Opacity set 
to 50% and the Size 
set to 50, I was able to 
subtly remove the lines 
in the image. I don’t 
want to completely 
remove them, just fade 
them a little.
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 • Lighten under the eyes: Many people, even children, will have dark 
areas below their eyes, and you can use the Retouch brush to fade that 
area away. To do this, use the brush at a low opacity (30% is a good 
start) and a size just large enough to fit the area (about the same size 
as the iris of the eye is usually good). Paint a few brush strokes over the 
area—just enough to remove some of the darkness but not so much that 
it starts to look “smudgy” (FIGURES 4.25 and 4.26).

Skin Retouching Pane
The Skin Retouching pane is where the  
magic happens. Here you can remove 
blemishes, smooth skin, and more! The pane 
is set up for you to start with the top set-
ting, Blemishes, and work your way down. 
Working in order will give you the best  
overall results (FIGURE 4.27).

 • Face Size: The Face Size setting deter-
mines the initial mask size for the face: 
Large, Medium, or Small. This sets the 
masking area to look for flesh colors 
beyond the default mask; change it if the surrounding mask is encom-
passing too much or too little of the skin on the face. You can preview 
the mask by clicking the drop-down and hovering over the sizes. In addi-
tion, you can refine the mask by using the Brush tool. 

 • Blemishes: Ranging from 0 to 100, the Blemishes slider removes 
medium-size blemishes, such as acne, freckles, large pores, and even 
lines in the face while retaining the pore structure in the skin. When 

FIGURE 4.25 (left) Most 
people have dark areas 
under their eyes.

FIGURE 4.26 (right)  
To fade the dark areas 
away without com-
pletely removing them 
and making them look 
“smudgy,” I used the 
Retouch brush with 
the Size set to 150, 
Feather at 125, and the 
Opacity set to 50%.

FIGURE 4.27 These are the 
default settings of the Skin 
Retouching pane.

NOTE

The Skin Retouching 
settings adjust only 
the skin areas in your 
image, so be sure 
the mask is good-
to-go with the Face 
Edit tool before you 
start your edits. 

NOTE

Changing the Face 
Size setting resets 
any changes made 
to the mask with the 
Brush tool, so be 
sure to set the Face 
Size before using  
the brush to refine 
the mask.
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using this slider for females and children, try setting it between 60 and 
80. For males, keep the setting under 50.

 • Smoothing: This setting smoothes the skin and is a good complement 
to the Blemishes slider and helps add a soft, healthy glow to the face. 
Be careful to not be heavy-handed with this slider, or you’ll end up with 
skin that looks plastic and surreal (FIGURE 4.28). Although it ranges from 
0 to 100, aim to keep the setting under 30, which is a good guideline for 
most skin types (FIGURE 4.29). 

FIGURE 4.28  
Be careful to not 
overdo the smoothing 
slider. This image has  
a Smoothing setting  
of 60, which adds  
too much softening  
to the skin.

FIGURE 4.29 Using a 
lower Smoothing set-
ting will typically give 
you the best results; 
here a setting of 20 
adds a subtle softness 
to the skin without  
losing detail.
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 • Shine: Light can emphasize any oil on the skin, making it look shiny.  
To counteract this, use the Shine slider to even out those shiny areas 
and better blend them with the surrounding skin (FIGURE 4.30). The slider 
has settings ranging from 0 to 100; simply move the slider to the right 
until the shine has disappeared (FIGURE 4.31).

 • Shadows: The Shadows adjustment (between 0 and 100) helps when 
you have an image with harsh shadows on the face. Moving this slider to 
the right softens those shadows and evens out the light over the face. 

FIGURE 4.30  
This woman has some 
shine on her face;  
I’m going to use the 
Shine slider to make it 
less apparent.

FIGURE 4.31 I used 
the Shine slider at a 
setting of 75 to reduce 
the shine on the  
woman’s face. 
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 • Texture: Usually used in conjunction with the Smoothing slider, the 
Texture setting adds texture to the skin. If you inadvertently smooth out 
too much of the skin’s natural texture but need to be a bit heavy on the 
Smoothing slider, use the Texture slider to replace some of what you  
lost. The setting ranges from 0 to 100, but you’re better off using the 
lowest setting possible to add just a small amount of texture back into 
the image.

 • Evenness: When your subject’s face has areas of redness (blotchy 
patches or just rosy cheeks), you can use the Evenness slider (0 to 100) 
to even out the overall skin tone. As you slide the slider to the right, the 
red slowly disappears (FIGURES 4.32 and 4.33). Be careful, however, not 
to push the slider too far to the right or you’ll lose a lot of the overall 
color in the face.

FIGURE 4.32  
This little girl has very 
red, rosy cheeks.

FIGURE 4.33  
By moving the 
Evenness slider to  
50 I was able to 
remove much of the 
redness in her face.

HOT TIP

When using the 
Evenness slider, 
make sure to double-
check your mask 
to make sure that 
all areas of the skin 
(especially the pink 
and red areas) are 
masked in properly.
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 • Face Only check box: On by default, Face Only constrains adjustments 
to the skin on the face and any area you have painted in with the Brush 
tool. When you deselect this box, Perfect Portrait will search for other 
flesh-colored areas of your image and apply the corrections there as 
well. When working on an individual portrait, leave Face Only checked 
(FIGURE 4.34). If you’re retouching a portrait with very little or no clothing  
or you want to apply the same skin edits to an entire group portrait without 
selecting individual Face Boxes, then deselect the box to edit the entire 
group at the same time (FIGURE 4.35). 

NOTE

Be careful toggling Face Only if your image contains manual adjustments (like brushing in 
skin), as it will reset the mask and you would need to redo your changes. You can see the 
areas affected by toggling the mask view (Ctrl+M).

HOT TIP

To reset any of the individual adjustment panes, click Reset in the bottom right.

FIGURE 4.34 With the Face Only box checked, only the 
face will be affected by the Skin Retouching adjustments.

FIGURE 4.35 When you want to adjust all skin in your 
image, deselect the Face Only box.
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Color Correction
Most portraits look their best when they 
have a warm color cast to them. After all, 
people are most attractive when they have 
healthy, radiant, and even flushed skin. The 
opposite is a cool color cast, which can 
be an interesting stylized effect, but in a 
typical portrait it’s usually more of a distrac-
tion. If your shot’s color cast is less than 
idea, the Color Correction pane can help 
(FIGURE 4.36).

Even if you already made your color corrections to the image, sometimes 
it doesn’t hurt to make a few last-minute adjustments can really sell a look. 
Or, if you used a setting such as the Evenness slider in the Skin Retouching 
pane (which removes redness in the face), you may want to add some 
warmth back into your portrait to balance it out. Again, this is when Color 
Correction pane can be very useful. This pane’s settings will affect the entire 
image, not just the face and skin.

 • Amount: Ranging from 0 to 100, this setting determines the overall 
amount of color correction in your image. The more you move this slider 
to the right, the more intense the color correction in your image will be. 
By default the Color Correction pane is turned on but the Amount slider 
is set to 0, so you’ll need to adjust it for the additional settings to take 
effect.

 • Warmth: Use the Warmth slider to warm up or cool down the color 
tones in your portrait. The slider ranges from 0 to 100; by default it is set 
at the “original” warmth of your image (usually around a setting of 27). 
To warm up your image slide it to the right, and to cool it down slide it to 
the left (FIGURES 4.37 and 4.38).

FIGURE 4.36 The Color Correction 
pane enables you to warm up or cool 
down the colors in your image.

HOT TIP

The sliders in this 
pane work from 
top to bottom and 
are dependent on 
one another. You 
must first adjust the 
Amount slider in 
order to “activate” 
the Warmth slider, 
and after setting 
your Warmth you 
can then change the 
Color Shift setting.
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FIGURE 4.37 This is  
an example of warming 
up your image with  
the Warmth slider; in 
this example it’s at a 
setting of 53.

FIGURE 4.38 This is 
an example of cooling 
down your image with 
the Warmth slider; in 
this example it’s at a 
setting of 0.
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 • Color Shift: The Color Shift setting gives you more control over the type  
of warmth in the image. Slide the slider to the left (toward 1) to give your 
image reddish warmth, and slide it to the right (up to 100) to give it  
more yellow warmth. Keeping the slider somewhere in the middle (between 
25 and 75) creates a standard orange warmth (FIGURES 4.39–4.41).

FIGURE 4.39 To add 
reddish warmth, move 
the Color Shift slider 
toward the left.

FIGURE 4.40 To add 
yellowish warmth, 
move the Color Shift 
slider toward the right.

FIGURE 4.41 To add an 
orange warmth, keep 
the Color Shift slider in 
the middle.
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 • Ethnicity: The type of correction 
needed for each image depends on 
the original color of a person’s skin. 
Perfect Portrait includes six presets 
you can use to help the software find 
a good color match for your photo. 
These are usually good starting points 
for your image, or you can leave the 
setting’s default of Average and  
make your adjustments manually 
(FIGURE 4.42). 
 

HOT TIP

If you have more than one Face Box in your photo and want to use the same settings 
for the other faces, you can copy and paste the settings over to the other faces. Select 
the face you want to copy, choose Face > Copy Settings in the menu bar, use the Face 
Select tool to select a different Face Box, and then choose Face > Paste Settings. All  
the settings from the adjustment panes on the right will be applied to your currently 
selected face.

Enhancing the Eyes and Mouth
The Mouth & Eyes pane is where you will be able to make adjustments spe-
cifically to, not surprisingly, the eyes and mouth. A person’s eyes are the most 
important aspect of nearly all portraits, and  
this pane offers tools specifically to make 
those beautiful eyes stand out. Also, nobody 
likes yellow teeth, and you can use a slider  
to remove the yellow and brighten your 
subject’s pearly whites faster than a dentist. 
Each of these settings is directly related to 
the controls over the eyes and mouth you 
adjusted earlier in this chapter, so be sure 
that they’re properly positioned to get 
the best results (FIGURE 4.43):

FIGURE 4.42 The Ethnicity drop-
down gives you a good starting 
place, depending on the skin-tone  
of your model.

FIGURE 4.43 The Mouth & Eyes 
pane allows you to make enhance-
ments to the eyes and mouth.

HOT TIP

When using this 
pane, try hiding the 
controls over the 
eyes and mouth so 
that you can see 
your changes much 
more clearly. Simply 
click on the Hide 
Controls setting in 
the Tool Options bar.
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Eyes Whitening: The Eyes Whitening slider brightens the white portion of 
the eyeball and ranges from 0 to 100. Between 20 and 50 is a good place 
to start, and be careful about pushing too far with this setting. White eyeballs 
are nice, but slide it too far to the right and they might start to look unrealistic 
(FIGURES 4.44 and 4.45).

 • Eyes Detail: When we look at a photograph our eyes always go to the 
sharpest portion of a scene. Because the eyes are the most important 
area in most portraits, adding a bit of sharpening and clarity to them 
makes sense. The Eyes Detail slider ranges from 0 to 100; to add a 

FIGURE 4.44  
This image shows the 
eyes with no adjust-
ments applied.

FIGURE 4.45  
By moving the 
Whitening slider to 50, 
I was able to add a 
subtle amount of light-
ening to this girl’s eyes.
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touch of sharpness to the eyes, move the slider to the right. Sharpening 
the eyes can make them sparkle and give your image the balance it 
needs, but to keep it realistic don’t be too heavy-handed with this setting 
(FIGURE 4.46).

 • Mouth Whitening: Ranging from 0 to 100, the Mouth Whitening slider 
brightens and whitens the teeth all at once. Try to keep this setting at 
around 50 for most images, because pushing the number too high may 
give your subjects unnaturally whitened teeth. Also, if there are no teeth 
in your portrait keep this setting at 0 (FIGURES 4.47 and 4.48).

FIGURE 4.46 Setting 
the Detail slider to 25 
adds a good amount of 
detail to the eyes with-
out overdoing it.

FIGURE 4.47 This 
image shows the 
mouth with no adjust-
ments applied.
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 • Mouth Vibrance: This setting adds saturation to the lips to make them 
a brighter color. The setting ranges from 0 to 100, and I find that setting 
it anywhere under 50 does a good job of making the color pop without 
overdoing it (FIGURE 4.49).

FIGURE 4.48  
By moving the 
Whitening slider to 60 
I was able to add a 
subtle amount of light-
ening to this girl’s teeth 
without affecting the 
inside of her mouth.

FIGURE 4.49  
The Vibrance slider 
intensifies the red in 
the lips.
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Effects and Presets
Perfect Portrait ships with a good selection of effects you can use with your 
images. When you launch the application, Perfect Portrait applies basic 
adjustments to your image, and from there you can play with the effects 
to see if another works better. If you want to set the initial settings for the 
adjustments that will be applied upon launching Perfect Portrait, go to Edit > 
Settings. Here you can select the intensity of the default adjustments (Natural 
or Strong), apply adjustments only to the skin (Skin Only), or select your 
own preset from the My Settings option at the very bottom (FIGURE 4.50). 
This is a great way to customize the intensity and application of the default 
settings to ensure that your portraits come out perfectly every time. After you 
make changes in the Settings window, the effects will be applied to all future 
images launched in Perfect Portrait.

To apply an effect, select the face you want to work on by clicking it with 
the Face Select tool, click the folder drop-down, and then click an effect in 
the Effects tab to apply it (FIGURE 4.51). If you want to apply different effects 
to more than one person in your image, such as with a group photo, use 
the arrows in the Tool Options bar to select the individual Face Boxes and 
then apply the appropriate effect. Both effects and presets will override any 
changes you have made in the adjustment panes, so apply these before mak-
ing additional refinements.

FIGURE 4.50 You can 
set the default Perfect 
Portrait adjustments in 
the Settings dialog box.
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Another great thing you can do in Perfect Portrait is save your own presets 
and then apply them to future images. To do this, make sure that a Face Box 
is selected and then choose Preset > Save Preset. These presets will then 
appear in the Presets tab on the left side of the window. Custom presets are 
especially useful when you have a large number of images to edit from the 
same person or group of people, such as from a senior portrait or engage-
ment shoot. You can save the settings made in the adjustment panes (Skin 
Retouching, Color Correction, and Mouth & Eyes) and use them for your 
group of images. As with some of the other products in the suite, you can 
favorite any effect or preset and save it to the Favorites tab by clicking on the 
flag icon to the right of its thumbnail.

You also have the ability to batch process images with Perfect Portrait; please 
turn to Chapter 1, “Getting Started,” for a detailed explanation on how to do 
that using Lightroom and Photoshop.

HOT TIP

Batch processing in Perfect Portrait works only with photographs that have a single per-
son in the image. You need to process group photos manually to tell the software which 
preset should be applied to each individual face or use a “skin only” preset, which will not 
make adjustments to the eyes and mouth.

FIGURE 4.51 Perfect Portrait offers several effects for use with your portraits.
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Cleaning Up Skin
Faces with several blemishes are some of the more difficult images to edit. In this image of 
my niece, I was able to get rid of the blemishes under her chin and make it blend well with 
the rest of her face by using Perfect Portrait.
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Step 1
I started off with my image inside of  
Perfect Portrait. The software immediately 
found the girl’s face, so I clicked once 
inside the green square to start my edits 
and Perfect Portrait immediately located the 
eyes and mouth.

Step 2
The controls over the eyes and mouth needed 
some adjustment, so I fixed them by clicking 
on the points and dragging them to the 
correct spots. I also used the brush to make 
certain that the skin on the face was fully 
showing, especially the areas where the 
blemishes were most severe.

Step 3
Then I went over to the Effects tab on the 
left and applied the Heavy Retouch effect 
from inside the Children category. This did 
a good job of smoothing away most of the 
blemishes on the chin.

Step 4
To continue the retouch process, I selected 
the Retouch brush from the tool-well. Then  
I set the Size to 125, the Feather to 25, and 
the Opacity to 50%, and clicked several 
times in the image over the areas where the 
blemishes were most severe. I did this until  
I removed the majority of the blemishes while 
keeping the skin tone and texture intact.
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Step 6
The last step was to apply the effect. When 
I preview the before and after images, I can 
tell that the blemishes have faded away 
nicely without a loss of detail in the skin.

Step 5
Next I directed my attention to the  
Mouth & Eyes pane on the right side of  
the screen. Since her eyes are squinting 
and not very visible, I decided to move  
both sliders to 0. Then I increased the 
Whitening slider for the Mouth to 85.
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Index
8- versus 16-bit files, 8

A

actions
recording, 30
stopping recording, 31

Adjust Mask pane
Black Contrast setting, 106
Feather setting, 106
Grow/Shrink setting, 107
Reduce Noise setting, 107
White Contrast setting, 106

Adjustment panes for Perfect B&W. 
See also Perfect B&W

activating effects, 199
Blending, 210–211
Border, 207–208
Color Response, 201–202
Film Grain, 204–205
Glow, 202–203
Sharpening, 209–210
Tone, 200–201
Tone Curve, 202
Toner, 205–206
Vignette, 206–207

Adobe RGB color profile, 8
All Layers view mode, blurry 

backgrounds for composites, 
296

Aperture
batch processing from, 28–29
opening images from, 21
processing files from, 21
saving files in, 21

Automate option, accessing, 30

B

backgrounds. See also blurry 
backgrounds for composites; 
white background

removing with Magic brush, 95
removing with Pen tool, 98

backing up presets, 25
batch processing

from Aperture, 28–29
inside Perfect Layers, 32
from Lightroom, 27–28
from Photoshop, 30–32
for time-lapse photography, 

323–329
black and white images. See also 

Perfect B&W
converting portraits to, 225–227
converting to, 303–312

film look, 219–221
landscape image, 222

black conceals, white reveals, 49–51
blemishes, removing, 133
blending modes

availability, 41
Color, 45, 47
default, 44
Hard Light, 45
Harsh Light, 47
Lighten and Darken, 41–42
Multiply, 45
Overlay, 45–46
Screen, 44
Screen and Multiply, 41, 43
Soft Light, 45–46
viewing changes from, 47

Blending Options window
accessing, 167
adding color pop, 170
adding drama, 167
blending borders, 171
manipulating texture, 167
Overlay mode, 167–168
Soft Light mode, 169
Texturizer effect, 169

blur filter, comparing to FocalPoint, 
233

Blur pane in FocalPoint
Amount slider, 243
Aperture setting, 244–245
Curvature setting, 246–247
Lens settings, 243
Optical Quality setting, 244–245
Rotation setting, 246–247
Version setting, 242

Blur tool
applying to images, 103
using, 103

blurry backgrounds for composites. 
See also backgrounds; 
compositing example

adjusting default blur, 301
All Layers view mode, 296
Brush tool, 295
Chisel tool, 298
FocalPoint, 300, 302
Highlight Bloom setting, 301
Layer mask, 299
Magic brush, 296
Perfect Layers, 293, 299
Perfect Mask, 294
removing halo effect, 298
removing in-focus part, 300
saving progress, 299
Vignette pane, 302

borders, blending, 171
box, drawing with Zoom tool, 13
Browser pane for effects

Effects tab, 156
Favorites tab, 157
features, 155–156
library, 155–156
My Presets tab, 157

Browser pane for Perfect B&W
Effects tab, 198
Favorites tab, 198–199
My Presets tab, 198
resetting adjustments, 198

brush effects. See also Perfect Mask 
brushes

features, 184
paint-in, 184

Brush tool, blurry backgrounds for 
composites, 295

brushes. See Perfect Mask brushes
Bucket tool, using, 103–104

C

canvas size, adjusting, 72
Chisel tool

applying to images, 103
blurry backgrounds for 

composites, 298
using, 102–103

cleanup tools
Blur, 103
Bucket, 103–104
Chisel, 102–103
Pen, 98–102

clipping, checking for, 16–17
Cmd key. See keyboard shortcuts
Color Correction pane. See masking 

with color
adding warmth, 141
Amount setting, 139
Color Shift setting, 141
Ethnicity drop-down, 142
Warmth slider, 139–140

Color Fill layers, using, 58
color profiles

Adobe RGB, 8
ProPhoto RGB, 8
sRGB, 8

color settings and calibration, 7–8
Color Spill brush, 97
ColorMunki website, 7
compositing example, 78–81. See 

also blurry backgrounds for 
composites

Copy With Layer Mask setting, 107
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Crop tool
Adjust Canvas Size option, 70
features, 69–70
Fit To Canvas option, 69–70
Fit To Layer option, 69–70

cropping images, 275–277
Ctrl key. See keyboard shortcuts
Current Layer setting, 107

D

deleting presets, 24–25
Document Size pane

Constrain Proportions setting, 
275

Lock Crop setting, 275
Preset setting, 274
Rotate Crop setting, 274–275

DOF (depth of field), deep versus 
shallow, 231

E

Effect Options pane
Black and White effect, 161
Blur effect, 161
Borders effect, 162
Color Enhancer effect, 162
Duotone effect, 163
Glow effect, 163
Photo Filter effect, 164
previewing images, 166
Sharpening effect, 164
Texturizer effect, 165
Tone Enhancer effect, 165
Vignette effect, 166

effects. See Perfect Effects
effects and presets, 146–147
Effects stack

Add button, 159
Amount slider, 158
Delete button, 159
Expand button, 159
features, 158
hiding layers, 160
Options button, 160
Stack visibility icon, 160

exporting and importing, 26–27
exposure blending, 76–77
eyes, lightening underneath, 134. 

See also Mouth & Eyes pane

F

Face Box
adding, 124
copying and pasting settings, 

142
removing, 125

Face Edit tool
hiding controls, 131
using, 126

Face Only, caution about toggling, 
138

faces
resetting edits to, 131
selecting, 124

file formats, saving, 24
files. See also images

8- versus 16-bit, 8
JPEG, 9
opening in Perfect Layers, 53
PNG, 9
preparing, 9–10
PSD, 9
RAW, 10
TIFF, 9

Film Grain pane, using, 280–281
FocalPoint

Blur pane, 242–247
blurry backgrounds for 

composites, 300
comparing to blur filter, 233
depth of field, 230–233
Focus brush, 249–252
interface, 230
launching, 233
Options pane, 248–249
Photoshop selections, 264–267
portrait blur with round Focus 

Bug, 258–260
presets, 256–257
tilt-shift look, 232–233, 261–263
usage guidelines, 232–233
using Photoshop with, 233
viewing masks in, 235
Vignette pane, 253–256

FocalPoint edits, blurry backgrounds 
for composites, 302

Focus brush
Brush Feather setting, 251
Brush Opacity setting, 251
default, 251
Save Mask As Alpha setting, 

251–252
using, 249–251, 259
using mask in Photoshop, 252
Wacom tablets, 251

Focus Bug
adding to photos, 240–241
features, 234
as mask, 234–235
portrait blur with, 258–260
removing from photos, 240–241
round, 258–260
toggling visibility, 241

Focus Bug settings
changing view modes, 236–237
Feather, 238–239
Moving and Resizing, 236
Opacity, 239–240
Round versus Planar, 237–238
Viewing the Grid, 236

focus point, determining, 234

G

Gallery Wrap setting, 285–289
groups

displaying, 11
hiding, 11
locating, 11

grunge and texture, adding, 313–322

H

halos, removing, 102, 298
Hand tool

described, 13
keyboard shortcut, 13

head-swap, doing, 74–75
Highlight Bloom setting, 301
Histogram pane, 16–18

I

Image Processor, using, 31
image size, returning to original of, 

273
images. See also files

opening in Perfect Layers, 52–54
rotating images, 68
saving, 24

importing and exporting, 26–27
installing

plug-ins, 4
software, 2–4

J

JPEG files, using, 9

K

keyboard shortcuts
duplicating layers, 55
Hand tool, 13
hiding groups, 11
mask preview toggle, 182
panes in Perfect B&W, 199
previews, 12
saving images, 24
undoing merged layers, 57
Zoom tool, 13
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L

landscape photo, exposure blending 
with, 76–77

Layer Mask setting, 107, 299
layer visibility, 54–55
layers. See also merged composite 

layers; Perfect Layers
blending, 37
changing interaction of, 40
explained, 37–40
order of, 40
resizing with Transform tool, 68
using, 39

Lightroom
batch processing from, 27–28
batching photos, 19
Edit In method, 19–20
editing options, 20
opening files from, 19

Lightroom Plug-Ins options
PSD, 5
Same as Source, 5
TIFF or JPEG, 6

live preview feature, 59
Loupe pane, 16

M

Magic brush
blurry backgrounds for 

composites, 296
improving accuracy of, 96
removing backgrounds, 95
Segment Scaling, 96
Threshold setting, 94
Transition setting, 94
using, 95

mask preview, toggling, 182
Mask View modes, 67
masking, black conceals, white 

reveals, 49–51. See also 
Perfect Mask

Masking brush settings
Feather, 60, 176
Mode toggle, 175
Opacity, 60, 176
Paint In, 59
Paint Out, 59–60
Perfect Brush, 60–61, 177
Size, 60, 176

Masking Bug
applying texture, 181
Feather option, 62, 178–179
features, 61, 64, 178
grid overlay, 182
Grid setting, 64
moving around, 61
Opacity option, 63, 180
reducing opacity of, 64–65

Shape setting, 63
Shape toggle, 181

masking features
Copy and Paste Mask, 65–66
Invert Mask, 65–66
Reset Mask, 65–66
Show Mask, 66

Masking menu options
Copy and Paste, 182
Invert Mask, 183
Reset Mask, 184
Show Mask, 182

masking with color. See also Color 
Correction pane

Color Spill brush, 97
Drop Color eyedropper, 92–94
Keep Color eyedropper, 92–94
Magic brush, 94–96

masks
accessing, 51
adjusting, 106–108
applying, 106–108
benefits, 50
cleaning up edges of, 102
hiding, 49
for isolating skin, 129–131
previewing, 104–105
viewing in FocalPoint, 235

megapixel conversions, 272
Memory Usage setting, 6
Merge All Layers option, 57
Merge Layers option, 57
merged composite layers, creating in 

Photoshop, 23. See also layers
Mouth & Eyes pane, 142. See also 

eyes
Eyes detail slider, 143–144
Eyes Whitening slider, 143
Mouth Vibrance setting, 145
Mouth Whitening slider, 144

N

Navigator pane, 15
New Layer setting, 107

O

objects, transparency of, 117–119
onOne Extension panel, using with 

Photoshop, 22
onOne Software

installing, 2–4
introductory video, 4
Marketplace, 174
registering, 2
support page, 19
uninstalling, 4

Opacity setting, changing, 48–49

Options pane in FocalPoint
Brightness and Contrast, 249
Film Grain, 249
Highlight Bloom, 248

P

panes
collapsing, 11
expanding, 11

Pen tool
Classic mode, 100
clicking points, 99
closing paths, 100–101
going around corners, 99
Magnetic mode, 99
moving points in selections, 100
refining selections, 100
removing areas, 101
reversing to redo, 99
Shift key for straight lines, 99
using, 98–102

Perfect B&W. See also Adjustment 
panes for Perfect B&W; black 
and white images

Brightness brush, 212
Browser pane, 197–198
brush options, 216–217
class look, 197
Contrast brush, 213
creative control, 197
interface, 196
keyboard shortcuts for panes, 

199
saving presets, 218
Selective Color brush, 216
selective coloring, 197
Targeted Brightness tool, 214–

215, 218
vintage look, 197

Perfect Brush, using, 177
Perfect Effects

applying effects, 157
blending options, 167–171
Browser pane, 155–157
brush effects, 184
color correction, 155
color enhancement, 185–186
creative control, 154
Effect Options pane, 161–166
Effects stack, 158–160
enhancing portraits, 190–193
importing presets, 173–174
interface, 154
Masking brush, 175–177
Masking Bug, 178–182
Masking menu, 182–184
saving presets, 172–173
selective adjustments, 155
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stylizing landscape image, 
187–189

tone correction, 155
tone enhancement, 185–186

Perfect Layers. See also layers
adding images as layers, 53
batch processing in, 32
blending layers, 37
blending modes, 41–47
blurry backgrounds for 

composites, 299
Browser | Extras pane, 52
Color Fill layers, 58
creating blank files, 53
creating collages, 37
customizing album pages, 37
deleting layers, 55
duplicating layers, 55
editing nondestructively, 37
interface, 36
launching images into, 21
Layers pane, 54–58
Mask View modes, 67
Merge All Layers option, 57
Merge Layers option, 56–57
New Stamped Layer option, 58
opacity, 48–49
opening images within, 52–54
opening multiple images, 53
pre-installed backgrounds, 53
renaming layers, 55
swapping heads, 37
undoing deletion of, 55
undoing Merge action, 57
using, 36–37
working from, 18
working from PSD files, 37

Perfect Mask. See also masking
blurry backgrounds for 

composites, 294
composite work, 85
interface, 84
masking subjects, 85
preparing for use of, 86
removing backgrounds, 85
replacing sky, 84–85, 109–112

Perfect Mask brushes. See also 
brush effects

Auto Expand setting, 89
Brush tool, 87
Color Decontamination, 92
Feather setting, 87
Keep and Drop brushes, 87–88, 

90
Opacity setting, 87
redoing strokes, 87
Refine brush, 91–92

Refine setting, 88
Segment setting, 88–89
Size setting, 87
Tolerance setting, 89

Perfect Photo Suite 7 
adding products manually, 19
installer, 2–3

Perfect Portrait. See also portrait 
retouching

batch edits, 123
batch processing in, 147
interface, 122
presets, 123
quick edits, 122
retouches, 123
setting default adjustments, 146
uses, 122–123

Perfect Resize
canvas wraps, 271
cropping images, 275
Document Size pane, 274–275
editions, 271
Film Grain pane, 280
Gallery Wrap setting, 285–289
image enlargement, 270–271
interface, 270
Pixel Dimensions pane, 273
preparation for printing, 271
presets and cropping, 276–277
resolution, 271–273
returning to original image size, 

273
Settings pane, 277–279
Sharpening pane, 279–280
tiled files, 271
Tiling pane, 282–285
Unsharp Masks, 280

Performance options
Memory Usage, 6
RAM (Random Access Memory), 

6
Segmented Brush Undo, 7
VRAM Usage, 7

Photoshop
batch processing from, 30–32
merged composite layers, 23
Smart Filters, 23
Smart Objects, 23
using masks in Focus Bug, 252
using onOne Extension panel 

with, 22
using with FocalPoint, 233

Photoshop selections, using with 
FocalPoint, 264–267

Pixel Dimensions pane, 273
pixels, explained, 272–273
plug-ins, installing, 4

PNG files, using, 9
portrait retouching. See also Perfect 

Portrait
facial recognition, 123–126
refining faces, 126–131

portraits
converting to black and white, 

225–227
effects for, 146–147

Preferences settings
accessing, 4
Lightroom Plug-Ins, 5
Performance, 6–7
Working Color Space, 5

presets
backing up, 25
creating for batch processing, 

27–28
deleting, 25
editing details of, 25
editing for Perfect Effects, 173
and effects, 146–147
FocalPoint, 256–257
importing for Perfect Effects, 

173–174
organizing, 26
in Perfect Resize, 276
resaving for Perfect Effects, 173
saving, 25
saving for Perfect Effects, 

172–173
saving to Perfect B&W, 218

presets folder, accessing, 25
Preview modes, 12
previewing masks, 104–105
print size, relationship to resolution, 

272
ProPhoto RGB color profile, 8
PSB files, 24
PSD files

saving images as, 24
using, 9–10

R

RAM (Random Access Memory), 6
RAW files, using, 10
recording

actions, 30
steps in actions, 30

Reduce Noise tool, 107
registering software, 2
removing halo effect, 102, 298
resetting settings, 86
resize features, caution about, 69
resizing. See Perfect Resize
resizing layers, 68
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resolution
megapixel conversions, 272
pixels, 271
as ppi (pixels per inch), 272
print size, 272

Retouch brush
Feather setting, 73
features, 73
Opacity setting, 73
Size setting, 73

rotating images, 68

S

saving
file formats, 24
files in Aperture, 21
images, 24
presets for Perfect Effects, 

172–173
presets to Perfect B&W, 218
progress, 299

settings, resetting, 86
Settings pane in Perfect Resize

Image Type drop-down, 277
Method setting, 277
Smoothness setting, 279
Texture setting, 278
Threshold setting, 279

sharpening images
High Pass option, 280
Progressive option, 280
Unsharp Masks, 280

size of image, returning to original 
version, 273

skin, isolating with mask, 129–131
skin retouching

resetting adjustment panes, 138
Retouch brush, 132–134
steps, 148–150

Skin Retouching pane
Blemishes slider, 134–135
Evenness slider, 137
Face Only check box, 138
Face Size setting, 134
Shadows adjustment, 136
Shine slider, 136
Smoothing setting, 135
Texture setting, 137

sky replacement, 84–85, 109–112, 
303–312

Smart Filters, using with Smart 
Objects, 23

Smart Objects, editing with, 23
software. See onOne Software
Spyder website, 7
sRBG color profile, 8

T

texture and grunge, adding, 313–322
Texturizer effect, blending, 169
thumbnails, generating from 

Navigator, 15
TIFF files, using, 9
Tiling pane, using in Perfect Resize, 

282–285
tilt-shift look, creating, 261–263
time-lapse photography, batch 

processing for, 323–329
Tool Options bar, 14
tools

accessing, 13
Hand tool, 13
Zoom tool, 13

tool-well, 13
Transform tool

Apply button, 69
Cancel button, 69
features, 68
Fill button, 69
resizing layers, 68
rotating images, 68
Rotation setting, 69
Scale setting, 69
Tool Options bar, 68–69
Width and Height settings, 

68–69
transparent objects, working with, 

117–119
Trim tool, using, 71

U

uninstalling onOne Software, 4
Unsharp Masks, using, 280

V

views, changing, 12
Vignette pane in FocalPoint

blurry backgrounds for 
composites, 302

Lightness slider, 253
Midpoint slider, 254
Vignette Follows Focus Bug, 

255–256
VRAM (Virtual RAM), 6–7

W

W icon, appearance in Tool Options 
bar, 14

websites
ColorMunki, 7
onOne Software Marketplace, 174
onOne Software support page, 19
Spyder, 7

white background, removing, 113–
115. See also backgrounds

working color space profile, 8
workspace

groups, 11
Preview modes, 12

wrinkles and lines, fading, 133

Z

zoom, jumping to, 15
Zoom tool keyboard shortcut, 13
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